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5.0 Results 

 

After analyzing and developing the behavioral models for the Mechanical Design 

Desktop System, a specific implementation was carried out. The typical methodology that 

a designer would follow to design a machine element would be:  

• Search the Internet for information on the particular machine element. 

• Catalogue the requisite information on the desktop. 

• Read the design procedure before beginning the design process. 

• Enter the limitations imposed on the design 

• Solve the design equations till all the limitations have been satisfied. 

• Plot graphs to study the influence of changes in design parameters 

• Maintain a record of the optimal values. 

 

The implementation model is discussed using the specific example of the design of a V-

belt drive. The various features provided by the application have also been explained in 

detail. 

 

Figure 5.1 shows the initial screen encountered by the designer. 
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Figure 5.1: The main screen of the application. 
 

The following is the description of the menu items: 

 

Element: On clicking this menu, the designer can select a particular machine 

element to design. 

 

Search: There is one sub menu under this menu: 

1. Open Web Page: On clicking this menu item, the designer can use the 

services of a browser to track information resources on the web for 
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information regarding any machine element. Any commercial search 

engine can be used to locate these sources. The designer can also cut 

relevant design information from the web page using standard Windows 

keyboard command Ctrl – C. 

 

Information: There are two sub menus under this menu: 

1.Input Information: On clicking this menu item, the designer can save 

any information that has been copied from a website into a designer 

specified destination on the desktop. He can use the standard Windows 

keyboard command of Ctrl-V to paste the design information. 

2.Display Information: On clicking this menu item, the designer can 

view the contents of any file on the desktop containing the information 

previously saved.  

 

TKSolver: On clicking this menu item, the designer can instantiate TKSolver, which 

is not only an implicit solving tool but also contains a graphing utility for 

plotting graphs. 

 

Limitations: The limitations section can be used to enter the limitations or constraints 

imposed on the design. The designer can enter the values of these 

constraints in the textboxes provided beside the appropriate constraint. 
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Equation Number: All the equations pertaining to the design of a particular machine 

element are loaded onto this combo box along with the equation 

numbers and the page numbers being displayed for reference. 

 

Specify Parameter values: On selection of a particular equation, the involved 

parameters and corresponding text-boxes to specify input 

parameter values are loaded in this frame. The designer can 

then specify the input design parameter values. 

 

Results:          This section displays the values of the calculated design parameters. All 

the calculated design parameter values are displayed in the window.  

 

Copy value: On the finalization of the design parameter value, the designer can click 

the value in the results section that he wants to copy and then, that 

particular parameter name and value, is displayed in the box. The value 

can then be copied using a standard Windows command Ctrl-C and pasted 

in the design document using the standard Windows command Ctrl-V. 

 

Calculate: On clicking this button, the input parameters are sent to the solver and the 

output parameters are displayed in the Results section. 

 

Notes: On clicking the icon displayed, the designer can open a Microsoft® Word 

97 document, enter the various design issues, and maintain a proper 
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documentation of the entire design. The document can then be saved on 

the desktop in a destination of the designer’s choice.  

 

Prompt: The table, graph or standard that a designer needs to refer to for specifying 

the design parameter values in a given equation are displayed in this 

section. 

 

Close:   On clicking this button, the application can be closed. 

 

The working of all the above GUI components can be best illustrated by the means of the 

following example: 

 

Let us assume the designer wants to initially search for information available on the 

Internet regarding a particular machine element. Let us consider the design of a V-belt 

drive as a specific example. On clicking the Open web page menu item under the Search 

menu, a web browser window as shown in the Fig. 5.2 is presented to the designer.  
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Figure 5.2: The web browser window.  
 

The interface is similar to that of any standard web browser. The default address 

specified is: http://www.google.com, which is a search engine for locating information on 

the Internet. The designer can navigate to any website of his or her choice or any other 

search engine of his or her preference by editing the address in the Address field. 

 

In addition, there are some standard navigation buttons also provided above the address 

field. These buttons, from left to right, are the Back Button, Forward Button, Stop Button, 

http://www.google.com/
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Refresh Button, Home Button and Search Button, respectively. The functionality 

provided by these buttons is as follows: 

Back Button: 

On clicking this button, the designer can navigate to a previously viewed web 

page. 

Forward Button:  

On clicking this button, the designer can navigate from a previously viewed web 

page to the next web page, in the order of viewing. 

Stop Button:   

On clicking this button, the current web page stops loading.  

Refresh Button:  

On clicking this button, the web page reloads itself. 

Home button: 

On clicking this button, the designer can navigate to the default starting address: 

http://www.google.com. 

Search Button: 

On clicking this button, the designer can use the search engine provided by 

Internet Explorer® to search for information on the Internet. 

 

Once the designer locates the information of his choice, the information can be copied by 

highlighting the required information using the mouse, and by clicking on the right 

mouse button as shown in Fig. 5.3. 

 

http://www.google.com/
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Figure 5.3: Information to be copied by the designer. 
 

On selecting the copy option shown in the Fig. 5.3, the highlighted text is copied. The 

designer can also use the standard windows keyboard command Ctrl-C to copy the above 

text. 

 

After copying the text, the designer can revert back to the main application screen using 

the standard windows keyboard command ALT-TAB. Here, on clicking the Input 

Information menu item under the Information menu, the designer encounters the screen 

shown in Fig. 5.4. 
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Figure 5.4: The screen for saving information. 

 

The designer can paste the information, previously copied, into the text box provided. On 

specifying a destination folder and file name in the input boxes provided and clicking the 

Send to file button, the information is stored in the specified folder and file. Let the 

designer save the information to the belt folder under the filename tension.txt as shown in 

Fig. 5.5. 
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Figure 5.5: The destination folder and file where the information needs to be saved. 

 

If the designer desires to review the information in the course of the design process, the 

designer can access the information by clicking on the Display Information menu item 

under the Information menu. Under the File menu, if the designer clicks on the Open 

menu item, the various files on the desktop can be accessed as shown in Fig. 5.6. 
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Figure 5.6: The contents of the belt folder. 

 

The designer can then select the file tension.txt for viewing and click on the Open Button 

to open the file and view the contents as shown in Fig. 5.7. 
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Figure 5.7: The contents of the file tension.txt. 

 

On clicking the Exit button under the File menu, the designer can revert back to the main 

application screen. 

  

Let us consider a test case where the designer wants to design a V-belt drive. Using the 

procedure outlined above, the designer saves information regarding the design of the V-

belt drive and reviews the information. 

 

On being familiarized with the design process, the designer begins the design process by 

clicking the V-Belt submenu item under the Element menu. Then, the form for entering 
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the specification is encountered where the limitations/specifications of the design process 

can be entered in the textboxes provided as shown in Fig. 5.8. Simultaneously, all the 

relevant graphs, tables and standards that need to be referred to in the design process are 

also loaded.  

 

 

 
Figure 5.8: The form for entering specification names. 

 

On clicking the OK button, these specification names get transferred onto the Main form 

as shown in Fig. 5.9. 
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Figure 5.9: The transfer of specifications onto the main form. 

 

Let us consider a test case wherein the following limitations have been imposed: 

Speed of driving member, N2 = 3000 rpm. 

Speed of driven member, N1 should be greater than 1520 rpm. 

The limiting center distance = 22 inches. 

Space limits the diameter of the driving sheave to 10.3 inches. 

Space limits the diameter of the driven sheave to 5.5 inches. 

The power to be transmitted is 5 hp. 

The driven machinery has normal torque characteristic and is subject to medium shock. 
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The specific values for the design limitations can then be entered in the corresponding 

textboxes provided beside each of the design limitation names as shown in Fig. 5.10, so 

that the designer can keep track of the relevant limitations. 

 

 

 
Figure 5.10: The limitations imposed on the given test case. 

 

On clicking the arrow provided below the Source Name, the designer can view all the 

design equations involved in the design, in the prescribed order, and proceed to solve 

each of the design equations till each design limitation is satisfied. The list of design 

equations displayed to the designer is shown in Fig. 5.11. 
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Figure 5.11: The design equations involved in the design of a V-belt drive.  
 

The designer then proceeds to calculate the design power, PD, as the first step in the 

design. On selecting the particular equation and pressing the “Tab” key on the keyboard, 

the various parameters involved in the design equation with the respective labels and 

corresponding input boxes for specifying the input design parameter values appear in the 

Specify Parameter Values section. Simultaneously, the design equation number and the 

page number in the design book where the design equation is present are also displayed 

as shown in Fig. 5.12. The Prompt window indicates to the designer which table or graph 

needs to be referred to for specifying the design parameter values based on design 
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conditions or other design parameters. For this case, the designer needs to refer to Table 

17-9 in order to specify the value of the parameter, Ks, based on the characteristics of the 

driving machinery as shown in Fig. 5.12. 

 

 
 

Figure 5.12: Selection of a design equation and the displayed prompt for input design  
         parameter  selection. 

 

In order to specify the value of the service factor, Ks, the designer clicks the Tables menu 

to obtain the list of tables to be referred in the design process. In Fig. 5.13, the list of 

tables is listed and the designer can select any of the tables to choose the requisite design 

parameter values. For the above design equation, the designer refers Table 17-9. Figure 

5.14 shows the table as viewed by the designer. 
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Figure 5.13: The list of tables viewed on clicking the Table menu. 
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Figure 5.14: The view of Table 17-9 for the selection of the service factor, Ks. 

 

For the test case under consideration, since the driven machinery has normal torque 

characteristic and is subject to medium shock, the value selected may vary from 1.2 to 

1.4. Let the designer select a value of 1.2. 

 

On finalizing the selection, the Close button can be clicked to revert back to the main 

screen.  
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Here, the values of the power, P, and the service factor, Ks, can be entered in the 

corresponding input boxes as shown in Fig. 5.15. 

 

 
 

Figure 5.15: The input parameter values specified for the design equation. 

 

On clicking the Calculate button, the input design parameter values are sent to the solver 

and the calculated value of the design power, Pd, is displayed in the Results section as 

shown in Fig. 5.16. 
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Figure 5.16: The value of calculated design parameter Pd, displayed in the results              
                     section.  
 

The designer then moves onto the next design equation in the design process by selecting 

the next design equation from the Equation drop-down box. The selected design 

equation and the corresponding design parameters are shown in Fig. 5.17. 
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Figure 5.17: The input parameter boxes for the second design equation. 
 

In the case of this particular design equation, the designer will tentatively select the 

driven and driving sheave diameters from the Table 17-2 such that they satisfy the 

minimum diameters listed therein, and also, keep the specification of the speed of the 

driven sheave to be above 1520 rpm.  

 

To keep the number of belts to a minimum, the designer will select a B-section belt as the 

minimum sheave diameter is closely matched to the space limitation of 5.5 inches. This 

can be observed from Table 17-2, the contents of which are shown in Fig. 5.18. 
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Figure 5.18: Reference table for Standard designations for various V-belts for the  
                     selection of minimum sheave diameters. 
 

Let a minimum sheave diameter of 5.4 inches be chosen for the driving sheave, which 

satisfies the space constraints imposed on the given test case. Let us choose the trial value 

for the initial sheave diameter of the driven sheave to be 10.1 inches. The result of the 

above calculation appears in the Results section as shown in Fig. 5.19. 
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Figure 5.19: First trial calculations for selection of optimum sheave diameters. 
 

There is a need to select the sheave diameters such that the speed of driven member 

matches as closely as possible to the required design speed. Let a value of 10.2 inches be 

selected for the diameter of driven sheave. The diameter of the driving sheave has been 

fixed at 5.4 inches earlier. The values chosen for the diameters of the driving and driven 

sheaves satisfy the space restriction imposed on the respective sheave diameters and the 

result of the above calculation is shown in Fig. 5.20. 
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Figure 5.20: Second trial calculations for selection of optimum sheave diameters. 

 

The values selected for the sheave diameters can now be finalized as these values satisfy 

the stipulation that the design speed of the driven sheave should be greater than 1520 

rpm, keeping the value as close as possible, and, simultaneously, satisfy the limitations 

imposed by the space restrictions. 

 

The designer will then move onto the next step in the design process and calculate the 

small angle of contact for the belt which determines the value of the constant, Ka, in the 

power rating equation. As the values of the sheave diameters, d and D, have been 

finalized, the values for those parameters are displayed by the system. The designer 
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decides a tentative value for the center distance, C, to be 20 inches in this case. The 

results are displayed in Fig. 5.21. 

 

 
 

Figure 5.21: Calculations for the small angle of contact, Thetas. 
 

The next step in the design procedure is to calculate the pitch length of the belt. The 

selected design equation and the calculations are as shown in Fig. 5.22. In this case, all 

the three parameters, d, D and C, have been finalized in the previous equations and the 

value of the pitch length of the belt, Lp, can be calculated without specifying any design 

parameter value. In this case, the designer has to merely click the Calculate button to 

determine the value of the pitch length, Lp, as shown in Fig. 5.22. 
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Figure 5.22: Calculation of the pitch length, Lp, for the V-belt. 
 

The design now involves standardizing the belt size, for which the inside circumference 

of the belt needs to be determined and then, the standard needs to be referred, in order to 

standardize the belt selection.  The calculation of the inside circumference of the belt 

involves the selection of a length conversion quantity based on belt type, by referring to 

Table 17-4 as shown in Fig. 5.23. 
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Figure 5.23: Selection of length conversion quantity from Table 17-4. 

 

For a B type V-belt lying in the range of 35 to 240 inches, the conversion quantity is 1.8 

inches. The inside circumference is then calculated using the conversion quantity of 1.8, 

as shown in Fig. 5.24.  
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Figure 5.24: Calculation of the inside circumference of the V-belt. 

 

With the value of the inside circumference, thus calculated, the standardization of the belt 

is carried out by referring Table 17-7. As is evident from Fig. 5.25, the nearest standard 

size is a B-68. 
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Figure 5.25: Table for the standardization of V-belt lengths. 

 

On selecting the next design equation, the designer needs to refer to Table 17-6 for the 

specification of the constant, Ka, and Table 17-5 for the values of the design parameters, 

C1, C2, C3 and C4. These tables are shown in Fig. 5.26 and Fig. 5.27, respectively. 
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Figure 5.26: The table to be referred for the value of parameter, Ka. 

 

As the value of the D/d ratio is over 1.64, the value of design parameter, Ka, is fixed as 

1.1106. 
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Figure 5.27: Table for the selection of parameters C1, C2, C3 and C4. 

 

The values of the design parameters C1, C2, C3 and C4 are fixed on the basis of the type 

of V-belt selected. Their respective values are 1.506, 3.52, 0.0004193 and 0.2931,since 

we have selected a B-Type V-belt. 

 

On substituting the values of Ka, C1, C2, C3 and C4, the power rating can be calculated 

as shown in Fig. 5.28. 
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Figure 5.28: The design equation for the calculation of power rating. 

 

As the rating is based on the arc of contact of 180 degrees and an average belt length, it 

must be corrected using the next design equation as shown in Fig. 5.29. 
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Figure 5.29: The design equation for the correction of the power rating. 

 

In this case, the values of design parameters, K1 and K2, are to be selected from the 

Graph menu by referring Figure 17-4 and Table 17-7, respectively. As can be seen, the 

value of the angle of contact, Thetas, from the screen is 166.21 degrees. Referring to the 

V – to –V pulley curve in Figure 17-4, the value of the correction factor K1 is determined 

to be 0.98. The graph is as shown in Fig. 5.30. The value of length correction factor K2 is 

selected from Table 17-7 to be 0.94, based on the selected standard belt being B-68, as 

shown in Fig. 5.31. 
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Figure 5.30: Graph to be referred for the value of correction factor, K1. 
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Figure 5.31: The table for the selection of Length Correction factor, K2.  

 

The resultant value for the corrected power rating is 6.78 hp, as shown in Fig. 5.32. 
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Figure 5.32: The corrected power rating for the V-belt drive. 

 

Once the corrected power rating has been determined, the belt speed needs to be 

calculated. The calculated value for the belt speed, using the specifications of the driving 

sheave, is shown in Fig. 5.33. 
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Figure 5.33: The calculated value of belt speed. 

 

The number of belts required for the drive can now be calculated using the next design 

equation. As the input design parameters have already been calculated earlier, the 

corresponding values are displayed and the number of belts required for the test case can 

be calculated. The result is shown in Fig. 5.34. 
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Figure 5.34:  The calculation for the number of belts required for the V-belt drive. 

 

This completes the design process for the belt drive. The various iterations involved can 

be seen in the Results section.  

 

Now that the design parameters have been finalized the designer can select the optimal 

design parameter values and save the final design parameter values to document the 

design. This is accomplished by clicking on the icon in the Notes section. This opens a 

Microsoft® Word 97 document as shown in Fig. 5.35. 
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Figure 5.35: The documentation of the design can be done in a Microsoft® Word 97 
         document. 

 

As can be seen, all the features offered by Microsoft® Word 97 are now at the designer’s 

disposal to document and format the design. The designer can further switch between the 

main application and the Microsoft® Word 97 application by using the Alt and Tab keys 

of the keyboard in conjunction. On clicking on a design parameter of choice in the 

Results section, the design parameter is transferred into the Copy Value box. The designer 

can then highlight the contents in the Copy Value box, to transfer the contents to the 

design document, by using the standard Windows commands such as Ctrl-C to copy from 

the main screen and Ctrl-V to paste the selected design parameter into the design 
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document. The transfer of the design parameter is shown for the third calculated design 

parameter in Fig. 5.36. 

 

 
 

Figure 5.36: The transfer of the selected design parameter value into the Copy Value box  
                     on clicking a particular design parameter. 
 

The contents of this box can then be transferred to the design document by highlighting 

the contents and pressing Ctrl-C on the keyboard. Use Alt-Tab to switch to the 

Microsoft® Word 97 application, and then press Ctrl-V on the keyboard to paste the 

contents into the design document. This process is shown in Fig. 5.37 and Fig. 5.38. 
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Figure 5.37: The highlighting of the design parameter value in the Copy Value box. 
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Figure 5.38: The transfer of contents from the Main screen to the design document. 

 

On transferring all the required design parameters from the Main screen to the design 

document, the designer can add notes regarding the design procedure and finally, save the 

document to any destination on the desktop by using the File> Save command utility of 

the Microsoft® Word 97 application.  

 

The designer can also observe the change in design parameters in a design equation by 

using the plotting utility provided by TKSolver. TKSolver can be instantiated by clicking 

on the Open TKSolver menu button shown in Fig. 5.39.  
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Figure 5.39: TKSolver can be instantiated by clicking the Open TKSolver menu item. 

 

The interface for TKSolver is as shown in Fig. 5.40 and is similar to that of a spreadsheet. 

The designer can enter the design equation of his choice in the Rule sheet. 
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Figure 5.40: The user interface for TKSolver. 

 

The designer can enter a rule of his choice in the Rule column or open any pre-existing 

equation model. Let us consider the model of Equation 17.3. One can open this equation 

model by navigating to the “Machine Element Folder” on the desktop using the 

File>Open utility of TKSolver.  

 

Switch to the variable sheet by clicking on the window. Let us consider the case wherein 

the sheave diameters are fixed and the designer wants to check how the variation in 

center distance, C, affects the angle of contact, Thetas, of the V-belt over the sheave. 

 



Results 91

The values finalized for the diameter of the driven sheave, D, and diameter of the driving 

sheave, d, are present in the Input section of the Variable sheet. Since, ‘C’ is the 

independent design parameter, a test value should be entered in the Input section to 

indicate it. Also, insert ‘L’ in the Status field for both C and Thetas, since a list of values 

need to be generated for both the dependent and independent design parameters. All the 

above inputs can be seen in Fig. 5.41. 

 

 
 

Figure 5.41: The Variable sheet after entering the design parameter values. 
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In order to fill the input list, place the cursor on the independent variable C and select the 

List Fill… option on the Command menu. The List Fill window presents the designer 

with the options as shown in the Fig. 5.42. 

 

 
 

Figure 5.42: The List Fill Window. 

 

There are four ways to fill a list. Let the selection made be Linear, Fill by Step. Fill in the 

boxes in the List Fill dialog box as shown in Fig. 5.43. 
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Figure 5.43: The dialog box for List Fill. 

 

Finally, select Fill List in the dialog box. We see that C now has 11 elements according to 

the Element field on the List sheet. Place the right mouse button on C on the List sheet 

and click the right mouse button once to display the data as shown in Fig. 5.44. 
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Figure 5.44: First six elements of the C list. 

 

The C list is now full and the corresponding values for Thetas need to be calculated. The 

design equation provides the linkage between the design parameters. The values for the 

dependent design parameter, Thetas, can be generated by pressing F10 (or the List solve 

button on the tool bar) to invoke list solving. Thus, the corresponding calculated values 

for Thetas can be viewed by following the same procedure of placing the right mouse 

button on Thetas on the List sheet and right clicking as shown in Fig. 5.45. 
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Fig. 5.45: The first six calculated values of Thetas. 

 

Now, a table of data needs to be created containing the list values of both the design 

parameters. Click on the Table sheet and fill the Name and Title section as shown in Fig. 

5.46. 
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Figure 5.46: The Table sheet.  

 

Further, on right clicking on the Name, Plot1, we can specify the lists that make up the 

data set for the table. Enter the name of the two lists Thetas and C, as shown in Fig. 5.47. 
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Figure 5.47: The names of the lists comprising the Table.  

 

Now that the table containing values for both the dependent and independent design 

parameters has been created, the designer can create the plot by clicking on the Plot 

Wizard on the Tools menu. The Plot Wizard is as shown in Fig. 5.48.  
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Figure 5.48: The Plot Wizard in TKSolver. 

 

Choose the option Create a plot from a table of data that exists in your model... as shown 

in Fig. 5.49. 
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Fig. 5.49: The window for selecting the table in the Plot Wizard.  

 

If more than one table existed, the designer would have to highlight the table by clicking 

on it and then select the Select Table button. As this model consists of only one table, 

Plot1, the table can be selected by clicking the Select Table button as shown in Fig. 5.50. 
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Figure 5.50: The selection of the table to plot. 

 

Now, the Plot button can be clicked to give a selection of the various options for plotting 

the data as shown in Fig. 5.51. 
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Figure 5.51: The window depicting the various plotting options.  

 

Let us choose a line chart as shown in Fig. 5.51. On clicking the Style tab, we can select 

the style of the plot. Let us choose the style as shown in Fig. 5.52. 
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Figure 5.52: The various options under the Style tab. 

 

On clicking the Finish button, the corresponding data sets are plotted and resultant plot 

obtained is shown in Fig. 5.53. 
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Figure 5.53: The plot for the variation of Thetas and C. 

 

The designer further has the option of including the plot as a part of the design document 

by right clicking on the plot to obtain the pull down menu as shown in Fig. 5.54. He can 

then paste the plot in the design document of his choice by using Edit and Paste Special 

utility in Microsoft® Word 97 as shown in Fig. 5.55. 
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Figure 5.54: Pull down menu for the plot. 
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Figure 5.55: The paste special option in Microsoft® Word 97. 

 

The option to be selected is highlighted in Fig. 5.55 and the designer can paste the picture 

in the design document as shown in Fig. 5.56.  
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Fig. 5.56: The plot pasted in the design document. 

 

Thus, the designer can have all the design data related to a specific design in one design 

document and save the document on the desktop for future reference. 


